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Introduction  

For this Sitecore instance, multi-tiered security roles for individual users to 

prevent publishing are not needed, as this Sitecore “organization” is small.  

If in the future, a larger number of people are publishing content to the 

Beyondsoft.com website, additional roles can be set up to limit/promote an 

individual’s ability to publish or edit items. 

The “Simple workflow” will be implemented to regulate the publishing of 

items.  This should cut down on the overall number of use cases needed 

when testing this Sitecore implementation.  

Two roles have been established at the outset: admins and authors.  The 

author role of a Beyondsoft Sitecore user will be referred to as a Content 

Publisher.  This role will not be able to change design elements such as 

templates, renderings, components, or Standard Values.  This role will be 

limited to content manipulation/publishing only. 

 

In the BCI.com Publishing Guidelines section of this guide, best practices 

and other custom rules – specific to BCI.com – are discussed and explained. 

These instructions can be adapted as the site grows, but the basic style and 

formatting rules should be kept as close to the original information as 

possible. 
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Sitecore terms 

 Content Publisher: Responsible for manipulating, publishing, and 

reviewing content. 

 Content Editor: An editing tool that you can use to manage and edit 

all the content on the website.  

 Items: Items are the basic building blocks of the Sitecore website. An 

item can represent any kind of information that makes up a webpage. 

For example: a piece of text, a media file, a layout etc.  An item always 

has a name – an ID that uniquely identifies the item – and it is based 

on a template that defines which fields the item contains. In addition, 

an item can have multiple versions and multiple language versions. 

 Media items: A media item is composed of several fields and it 

always has a file attached to the Media field. A media item can be an 

image, a document, a video, or an audio file. In Sitecore, there is a 

difference between media files and media items. An image or video 

file that is stored on a local computer is called a media file. When a 

media file is uploaded to the Sitecore Media Library, the file is 

attached to a media item and is from then on referred to as a media 

item. 

 Media Library: All media items can be managed from the Media 

Library, such as images that can be embedded in a webpage or made 

available for download by visitors. The Media Library contains all 

media items such as images, documents, videos, and audio files. 
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Publishing basics 

The Content Editor appearance and functionality vary depending on the 

user’s roles, the local security settings, and the customizations that have 

been implemented on the Sitecore installation. 

 

Log in to Sitecore editing  

1. Log on to the Sitecore instance using the predetermined User name 

and Password. 
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2. Select Content Editor in the Sitecore desktop.

 
 

 

Navigating the user interface 

The Content Editor’s user interface consists of three main areas that you 

can customize to fit your individual needs when you work in the Content 

Editor. The three areas are:  

•The ribbon – the area where all the functionality is available. 

•The content tree – the area where all the items are organized. 

•The content area – the area where you can edit your items. 
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The ribbon 

The ribbon consists of the System menu  and tabs where all the 

functionality that you can use in the Content Editor is available. 

Depending on your access rights and security settings, the functionalities 

that are available to you in the ribbon can vary. As a minimum, you can 

expect to see: 

 

 

If you have more extensive access rights, you have access to more 

commands and more tabs. If you have complete access to the Content 

Editor or if you are a Sitecore administrator, you will see something like this: 
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The content tree 

One of the main features of the Content Editor is the content tree, which 

presents all the items that are created in your Sitecore installation. 

 

  

 

 

 

 

 

 

 

 

 

The Sitecore content tree has a similar structure to the one used in 

Windows Explorer. However, the Sitecore objects and groups are not 

represented by standard folder and file icons but by many different icons.  

You can expand and open every group in the Sitecore content tree just as 

you can with the folders in Windows Explorer. When there is a plus ‘+’ 

beside an icon, it contains subitems and can be expanded. When there is a 
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minus ‘-’ beside an icon, it has already been expanded and when there is no 

symbol, the item contains no subitems. 

 

The content area 

The content area is where you edit an item. When you click an item in the 

content tree, two tabs appear in the content area:  

•The Content tab, where you can edit any of the item’s field values.  

•The Search tab, where you can search through the selected item.  

In the top-right corner of the content area, additional functionality is 

available that is specific to the item that is selected.  

 

 

 

  

 

 

 

 

 

 

The functionalities are: 

•Navigate:  navigate to a specific section or field in the list of 

field values. 
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•Language:  toggle between the language versions of the 

item or create a new language version. 

•Versions: toggle between versions of the item or create a new 

version. 

•Validation warnings:  move your mouse over the individual icons 

to see the warnings related to the current item.  

•Edit Profile Cards:  edit the profile cards that are associated to 

the item. This is mostly relevant if you are a marketing user. 

 

Create an item in the Content Editor 
*Note: This process may only be used to create blogs and news stories. 

When you create a new item in the Content Editor, you must first select an 

item in the content tree to indicate where you want the new item to be 

located. You can create a new item as a sibling or a subitem to the item 

that you select: 

•A sibling is an item that you create at the same level as the selected 

item. 

•A subitem is an item that you create under the selected item. 

Insert an item 

1. In the Content Editor, navigate to the item where you want your new 

item to be located. 

 Right-click the item in the content tree, click Insert, and then 

click one of the suggested item types. 

 

2. Enter a name for the new item and click OK. 
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Every new item that you create automatically locks and opens in the 

Content Editor. You must unlock and save your items before other 

users can work on them. 

 

3. As appropriate, edit the new item or add subitems. 

 

Insert an item based on a template 

If you have sufficient access rights, you can create a new subitem from any 

template that is available in your Sitecore installation.  

To insert an item from a template: 

1. In the content tree, find and select the item that you want to create a 

subitem for. 

2. On the Home tab, in the Insert group, click the drop-down arrow 

and click Insert from template. 

3. In the Insert from Template dialog box, navigate to the template 

that you want to base the new item on. 
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Alternatively, you can right-click the item in the content tree, click Insert, 

and then click Insert from template. 

Note: To locate the template you can navigate through the content tree on 

the Browse tab, or you can use the Search tab to search for the item. 

4. In the Item name field, enter a name for the new item and click Insert. 

5. As appropriate, edit the new item, add subitems, or move it to another 

location. 

Important: You can create an item in an item bucket in exactly the same 

way as you create a regular item. If the template that the new item is based 

on is bucketable or if you make the item bucketable, the item is hidden in 

the item bucket. If the item or the item’s template is not bucketable, the 

item is visible in the item bucket. Consequently, you can have an item 

bucket that is a hybrid of hidden items and visible items. 

 

Edit the website content 

When you edit content in rich text fields, you can benefit from the 

advanced editing functionalities in the Rich Text Editor. 

Note: For consistency purposes, DO NOT update the size or class of the font. 

This could cause sizing issues, when viewing from mobile devices. 

 

The Rich Text Editor 

The Rich Text Editor is the standard text editor in Sitecore. In this editor, 

you can edit all the content in a rich text field. In the Rich Text Editor, you 

can:  

•Paste text from Microsoft Word.  

•Find and replace text. 
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•Insert pictures or other media items. 

•Insert and delete links to other parts of the website and to external 

websites. 

•Insert symbols. 

Note: The Rich Text Editor is a standard word processing tool, but in Sitecore, 

most of the formatting functionality has been removed because the style 

sheets and templates for a website determine the format of the items that 

content authors create and edit. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 

 

Microsoft Word  

You can use Microsoft Word as your text editor in Sitecore and benefit from 

all the functionality that is available in Microsoft Word. You can open the 

Word field editor from the Content Editor. 

•Insert a link to an item in Sitecore. 

•Insert an image from the Media Library. 

Important: To edit a text field in the Word field editor, your administrator 

must set up the text field as a Word field. In addition, make sure to use 

Microsoft Word 2007 or later and if using Internet Explorer, use Internet 

Explorer 7 or later. If you use Internet Explorer 8, you must configure your 

security settings to support Word fields in Sitecore. 

 

Edit a text field 

To edit a text field in the Content Editor: 
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1. In the Content Editor, navigate to the item or page that you want to 

edit. Make sure to select the relevant version and language of the 

item. 

2. To open the text editor: 

 From the Content Editor – in the content area, locate the Rich 

Text field you want to edit and click Show Editor.  

3. Make the appropriate changes to the content in the text field.  

 In the Rich Text Editor, if you prefer to edit the content in HTML 

format, click HTML. 

 

Note: Your Sitecore system administrator controls the features that are 

available to you. If you need more features, ask your administrator to make 

them available. 

 In a Word field, to insert a Sitecore link to another item on your 

website, click Insert a link. To insert an image from the Media 

Library, click Insert media item. If the image is not available in the 

Media Library, you can use the insert picture functionality in 

Microsoft Word.  
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Note: Images that you want to use regularly, you should upload to the Media 

Library. 

 

4. When you are finished editing the content, click Accept to save your 

changes. 

 

Lock and unlock an item 

In Sitecore, you can lock the item you are working on to prevent other 

users from editing the same item at the same time. If the item that you 

want to edit is already locked, you cannot edit it. You can only view it. 
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When you have finished editing the item, you must unlock the item to 

make it available to other users again.  

Depending on the setup of your Sitecore installation, you may be prompted 

to lock the item before you can edit it.  

A Sitecore administrator can have the authority to edit another user’s 

locked items. Therefore, an administrator and another user can edit an item 

at the same time. If a user saves changes to an item, and another user saves 

changes to the same item afterwards, a message box appears, asking the 

user if the previously saved changes should be overwritten. 

Important: Locking an item does not keep it from being published. If you 

are working on an item and you want to keep it from being published, you 

need to set up the publishing restrictions for the item.  

 

This topic outlines how to: 

•Lock an item 

•Unlock an item 

 

Lock an item 

To lock an item manually: 

1. In the Content Editor, navigate to the item or page that you want to 

edit. 

 In the Content Editor, on the Home tab, click Edit to lock the 

item. 
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Note: In the content tree, you can use the Quick actions to see a quick 

overview of the items that you have locked. Right-click left of the content tree 

and select My Locked Items. 

 

2. When you are finished editing the item, make sure to unlock the item 

again. 

 

Unlock an item 

If you have locked and edited numerous items, you can lose track of them. 

Sitecore keeps track of all the items that are locked, and by whom. In this 

way, you can easily lock one or more items at the same time.  

To unlock an item: 

1. To see a list of the items that are locked by you, or to unlock one or 

more items: 

 In the Content Editor, on the Review tab, in the Locks group, 

click My Items. 

 

Note: The number next to the My Items button on the ribbon indicates the 

number of items that you have locked. 

2. In the My Items dialog box, select the items that you want to unlock 

and click Unlock. To unlock all items at the same time, click Unlock 

All. 
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Delete an item 

Inevitably, you will need to delete content items from time to time. In the 

Content Editor, you can delete an item and all of its versions and subitems, 

or you can delete a single version of an item. 

This topic outlines how to: 

•Delete an item and its subitems and versions 

•Delete a version of an item 

 



BCI.com Sitecore Publishing Guide Publishing basics 19 

 
 

 

Delete an item, its subitems and versions 

To delete an item and all of its subitems and versions: 

1. In the Content Editor, navigate to the item or page that you want to 

delete. 

 In the Content Editor, on the Home tab, in the Operations 

group, click Delete. Alternatively, you can right-click the item in 

the content tree, and click Delete. 

2. If the item contains subitems, a message appears informing you that 

the item contains subitems and that these items will be deleted too. 

 To save any of the subitems, click Cancel and move them to 

another location.  

 To delete the item and its subitems, click OK. This deletes every 

version of the item in every language. 

 

 

 

 

 

 

 

If there are links to the item you delete, you must decide how to deal with 

the broken links in the Breaking Links dialog box that opens. 

1. In the Breaking Links dialog, you can: 

 Remove links – remove all the links that exist to this page. 

 Link to another item – change all the links to this page to link 

to another item. 
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 Leave links – manage the broken links in the Broken links 

report. 

 

2. To open the item that links to the item you want to delete and edit 

the link directly from there, click Edit Links. In the Edit Link dialog 

box, click Edit. 

3. In the Breaking Links dialog box, click Continue. 

4. If you selected Link to another item, in the content tree, click the 

item that you want to link to instead. To update the link, click OK. 

 

Delete a version of an item 

If you have created several different versions of an item, you can delete 

individual versions of the item without deleting the item or any of its other 

versions or subitems. 

To delete a version of an item: 

1. In the content tree, locate the item that has a version that you want to 

delete. 



BCI.com Sitecore Publishing Guide Publishing basics 21 

 
 

 

2. If the item is available in multiple languages or versions: 

 Click the Language button and select the language 

version that you want to delete. 

 

 
 

 Click the Versions button and select the version that you 

want to delete. 

 

3. On the Versions tab, in the Versions group, click Remove. The 

version that you have selected is deleted. 

 

Create an anchor and link to it 

An anchor is an HTML code that is used as a bookmark to create a link to a 

particular section within a page, for example, it could be a Back to top link 

that takes the user to the top of the current page.  

In Rich Text fields, you can use the Hyperlink Manager to create an anchor 

in your text, and then to create the link to your anchor. 

Note: In Word fields, you cannot access the Hyperlink Manager. Instead, you 

must use the Hyperlink functionality within Microsoft Word.  
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To create an anchor: 

1. In the Content Editor, navigate to the item where you want to insert an 

anchor. 

2. Open the Rich Text Editor and select the text or image that you want 

make an anchor. 

3. Click the Hyperlink Manager . 

4. In the Hyperlink Manager dialog, click the Anchor tab and in the 

Name field, enter a unique name for the anchor. 

 

5. Click OK. 

6. To create a link to this anchor, highlight the text that you want to add 

the link to and click Hyperlink Manager. On the Hyperlink tab, in 

the Existing Anchor field, choose the anchor you created and click 

OK. 
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Copy or duplicate an item 

In the Content Editor, you can create a new item by copying or duplicating 

an existing item  

Note: For items requiring a date stamp (blogs or other insights documents), 

creating NEW items is preferred to copying or duplicating. 

 Copy an item – copies the selected item and all its content and 

subitems to a location in the content tree that you specify. 

 Duplicate an item – copies the selected item and all its content and 

subitems to the same location in the content tree. 

Note: In Internet Explorer, you can also copy, cut, and paste items to and 

from the clipboard. The clipboard functionalities are available on the Home 

tab, in the Clipboard group, but due to JavaScript restrictions in other 

browsers, the Clipboard group appears only in Internet Explorer. 

Copy an item 

To copy an item to another location: 

1. In the content tree, locate and select the item that you want to copy. 

2. On the Home tab, in the Operations group, click Copy to. 

Alternatively, you can also right-click the item in the content tree, click 

Copying and then Copy to. 

3. In the Copy Item To dialog box, select the location where you want 

the copy the item to be stored. 
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Note: You can navigate to the location through the content tree on 

the Browse tab, or you can search for the location on the Search 

tab. 

4. Click Copy to create a copy of the item in the specified location.  

Now you can edit the new item, add subitems, or move the item to another 

location. 

Note: To copy multiple items at the same time, you must run a search for all 

the items that you want to copy and use the Copy results to search 

operation. 

Duplicate an item 

To duplicate an item: 
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1. In the content tree, locate and select the item that you want to 

duplicate. 

2. On the Home tab, in the Operations group, click Duplicate. 

Alternatively, you can right-click the item and click Duplicate. 

3. Enter a name for the new item and click OK. 

Now you can edit the new item, add subitems, or move the item to another 

location. 

 

Preview a webpage 

The preview functionality lets you preview all your items on your website 

without publishing them first. 

The preview functionality lets you: 

 Specify a preview date, so that you can view your website in the past 

or future, according to the publishing restrictions that are set up. 

 See how a webpage looks in different language versions. 

 Preview how the page displays on different devices. 

To preview a webpage: 

1. From the Content Editor, on the Publish tab, in the Publish section, 

click Preview. 

2. On the Experience tab, select the preview parameters: 

 Date – to specify another date to preview the webpage, in the 

Date group, click the date, or click the blue arrows to select the 

previous day or the next day. 

 Language – to view the page in a different language, in the 

Language group, click Language . 
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Note: The Experience tab might not be available to you if you 

do not have the necessary security permissions. Also, if the 

navigation links are showing up but not the full ribbon, click 

the down arrow on the right. 

3. Navigate through the pages to preview your whole website. 

Tip: In the preview mode, you can also use the search 

functionality to navigate to a specific page that you want to 

preview. 

 

 

 

Publish and unpublish an item 

When you edit or create new items in Sitecore, they must be published 

before they appear on your website. This lets you save unfinished items and 

decide exactly when the items are launched to the website. Conversely, 

when an item needs to be removed from the site, it must be unpublished. 

When you work in Sitecore, the items you save are saved to the Master 

database. When you publish items, the items are copied from the Master 

database to a publishing target, and from the publishing target, the website 

is launched. The default publishing target in Sitecore is the Web database. 
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You can choose to publish the entire website or a single item: 

 Site publishing – publishes your entire website starting from the root 

of the content tree. You can publish a site from the Content Editor or 

from the Sitecore Desktop. Only to be used if all changes in Sitecore 

should be published. 

 Item publishing – publishes the item you select in the Content Editor. 

The item can only be published if all its ancestors have been published. 

With item publishing, you can choose to include all of the selected 

item’s subitems and related items.  

Site publishing 

When you are ready to publish your website, you can run the publishing 

wizard, which guides you through the steps of publishing in Sitecore. You 

can run the publishing wizard from the Content Editor and the Sitecore 

Desktop. 

To publish the entire website: 

1. Open the Publish Site wizard from one of two locations in Sitecore: 

 From the Content Editor – on the Publish tab, in the Publish 

group, click the Publish drop-down arrow, and select Publish site. 

 

 From the Sitecore Desktop – click Sitecore Start , and then 

click Publish site. 
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2. In the Publish site wizard, specify the publishing mode for the website 

you are publishing: 

 Incremental Publish – publishes only items that are in the 

publishing queue. Every time you change an item, the item is 

automatically added to the publishing queue. If the changed item is 

part of a workflow, the item is added to the publishing queue when 

it reaches the final workflow state. 

Incremental Publish is the fastest way of publishing because 

Sitecore does not use resources to compare versions of the items 

that are in the publishing queue before publishing them. 
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Note: Incremental Publish is only available when you publish the 

entire website. 

 Smart Publish – publishes all items that have changed since the 

last publication. When you run a Smart publish, every item in the 

Master database is compared with the equivalent item in the target 

database and, if an item has changed, it is published. 

Comparing all items in the database makes this a time-consuming 

way of publishing your entire website, particularly if the content 

tree contains many items. 

 Republish – publishes everything. Republish overwrites every item 

in the target database with the equivalent item from the Master 

database, even if it has not changed. In this way, republishing 

removes all obsolete versions from the target database. You can 

use republishing to bring a new web database online, to restore a 

backup of the master database, and to add a new content 

language, a new publishing target, or other system items to the 

website. 
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3. In the Publishing language section, specify the language versions 

that you want to publish. 

4. In the Publishing targets section, specify the publishing targets that 

you want to publish to. 

5. Click Publish. When the publishing completes, you can see how many 

items were processed during publishing and the number of items 

created. updated on the target database. 

Item publishing 

When you are ready to publish an item to your website, you can run the 

publishing wizard, which guides you through the steps of publishing in 

Sitecore. You can run the publishing wizard from the Content Editor. 

To publish a single item: 

1. Open the Publish Item wizard from one of two locations in Sitecore: 

 From the Content Editor – select the item that you want to publish. 

On the Publish tab, in the Publish group, click the Publish drop-

down arrow, and select Publish item. 

 

Note: To publish the selected item in all languages to all publishing targets 

and avoid going through the steps of the publishing wizard, click Publish 

. 

2. In the Publish Item wizard, on the Settings page, specify the 

publishing mode: 
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 Smart publish – publishes the selected item if it has changed since 

the last publication. When you run Smart Publish, the selected item 

in the Master database is compared with the equivalent item in the 

target database and, if the item has changed, it is published. When 

you are publishing single items, Smart Publish is a quick way to 

make sure that all changes to a specific item and its subitems are 

published. 

 Republish – publishes everything. Republish overwrites the 

selected item in the target database with the equivalent item from 

the Master database – even if it has not changed. In this way, all 

obsolete versions are removed from the target database. You can 

use republishing to restore a backup of the master database and to 

add a new content language, a new publishing target, or other 

system items. 

 

3. To publish all the subitems of the selected item, select Publish 

subitems.  
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4. To publish all the related items to the selected item, select Publish 

related items. Related items can be: 

 Clone references – items that are clones of the selected item. 

 Media references – media items that are related to the selected 

item. 

 Alias references – items that are aliases of the selected item. 

5. In the Publishing language section, specify the language versions 

that you want publish. 

6. In the Publishing targets section, specify where you want to publish 

the items to. 

7. Click Publish. When the publishing completes, you can see how many 

items were processed during publishing and the number of items that 

were created, deleted, or updated on the target database. 
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Unpublishing 

If you decide to remove a page from the site, you will need to unpublish it, 

to make sure it cannot be discovered: 

To unpublish a page: 

1. In the PUBLISH tab, select Change and uncheck the box under 

Publishable, then click the OK button. 

 

2. Follow the instructions in the Item Publishing section to complete the 

process. 

Note: Using the dropdowns to determine unpublishing dates is not 

recommended. Manually unpublishing an item – as detailed above – is 

preferred. 
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Work in workflows 

To ensure that only items that have been approved are published, you can 

use workflows to formalize and enforce your company processes and 

procedures.  

A workflow is a series of states that reflects the work processes and 

procedures for creating web content in your organization. For example, 

your workflow states can correspond to the creation, review, and approval 

stages that items must go through before they are published on your 

website. 

A workflow can contain any number of workflow states and be as simple or 

complex as required. Items do not necessarily have to move through all the 

workflow states that you have defined — some states can be optional or 

only applicable to certain kinds of content. 

 Edit an item and move it to the next workflow state 

Note: An administrator can overwrite any of these workflow states and move 

an item through the states or publish the item at any given time. 

Furthermore, you can implement any number of different workflows. As a 

minimum, each workflow must contain two workflow states – one that is 

the initial workflow state and one that is the final workflow state. You can 

only publish an item in a workflow, if it is in the final workflow state. 

Typically, developers implement workflows, but it can be useful for content 

authors to understand how a workflow is constructed and implemented.  

The following workflow items are stored in the content tree: 

 Workflows – the main item that contains all the subitems that make 

up the workflow. 

 States – the basic building blocks of the workflow. The workflow states 

represent the different stages in your content creation process. 
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 Commands – the actions that must be performed by contributors to 

move the items through the workflow states. 

 Actions – the actions that are automatically performed on the items 

when they are in particular workflow states or when particular 

workflow commands are executed. 

An example of a workflow: 

 

After the workflow has been defined, the developer specifies the item 

templates that are subject to the workflow. Every time a content author 

creates or edits an item that is based on one of these templates, the item is 

sent to the initial workflow state of the workflow.  

Edit an item and move it to the next workflow state 

To send a content item to the next workflow state: 

1. In the Content Editor, navigate to the relevant item or page. 

2. Edit the item and save your changes. 

3. If the item is in a workflow, you can see the available workflow 

commands: 

 In the Content Editor, on the Review tab, in the Workflow 

group.  

In the following example, the workflow command Submit is displayed, 

and therefore this is the only workflow command that you can apply to 

this item in its current workflow state. 
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4. Click the relevant workflow command to send the item to the next 

workflow state.  

5. In the dialog box that appears, you can enter a comment about the 

page you have edited, and click OK. 

The item is now in the next workflow state and new workflow 

commands are available in the notification bar. If you do not have 

permission to edit the item in the current workflow state, you cannot 

lock the item for editing, and the workflow commands are not 

displayed. 
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Move an item 

You can move an item to a different location in the Content Editor. 

To move an item: 

1. In the Content Editor, navigate to the item or page that you want to 

move. 

 On the Home tab, in the Operations group, click Move to. 

Alternatively, you can right click the item in the content tree, click 

Copying and then click Move to. 

2. In the Move Item To dialog box, select the location that you want to 

move the item to. You can navigate to the location in the content tree 

on the Browse tab or search for the location on the Search tab. 

 

3. Click Move. 
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Insert an image 

In the Content Editor you can insert various types of media, typically 

images, into an image field, a Rich Text field, or a Word field. These media 

items can be images, animations, film clips, sound files, and so on. 

This topic outlines how to: 

 Insert an image into an image field 

 Insert an image into a text field 

Insert an image into an image field 

To insert or change an image in an image field: 

1. In the Content Editor, navigate to the item or page that you want to 

edit: 

 In the Content Editor, click the Content tab, locate the image field 

where you want to insert an image and click Browse.  

 

2. The Select Media dialog box displays all the items from the Media 

Library that are available for the image field you have chosen. 
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The items in the Select Media dialog box are not listed in any 

particular order, so use the search functionality or the predefined lists 

from the menu to find your image: 

 In the Media menu, use the links to quickly get a complete list of 

All image files, All video files, My images, Recently uploaded 

images, and Recently uploaded videos. 

 To filter the displayed media items according to specific metadata 

of the image, click the Filter drop-down arrow and select the 

required filters. The number in parenthesis indicates how many 

items are available for the filter. 
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 To search for a specific item, enter a search word in the Search 

field. 

 To navigate through the content tree to find the image that you 

want to use, click Tree View in the upper right corner. To go back 

to the list view, click List view .  

3. Select the image that you want to use, click Select Media, and the new 

image is inserted into the image field. 

Note: If the image that you want to use is not available, click Upload 

media to upload a new image to the Media Library.  

 

Insert an image into a text field 

To insert a media item into a text field: 

1. In the Content Editor, navigate to the text field, where you want to 

insert a media item.  

2. You can insert the image in one of the following fields:  

 To insert the image in the Rich Text Editor, open the editor from a 

Rich Text field and click Insert Sitecore Media . 

 To insert the image in a Word field, open Microsoft Word from a 

Word field and click Insert Media. 

Note: If you do not see the Insert Image button in the floating toolbar, 

click the More drop-down arrow. 

3. If the image is already in the Media Library, in the Insert Media Item 

dialog box, find and select the image that you want to insert and then 

click Insert. To locate the image, you can navigate through the content 

tree on the Media Library tab, or you can search for the item on the 

Search tab. 
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4. If the image is not available in the Media Library, click Upload.  

5. In the Upload File dialog box, click Browse and then select the image 

file that you want to use.  

 

6. In the Open dialog, click Open to upload the image file to the Media 

Library. 

7. The image file opens in the Content Editor. To save the new image and 

return to the Insert Media Item dialog box, click Save/Close.  

8. To insert the image in the text field, click Insert. 

Note: If you click Cancel, the Insert Media Item dialog box closes, but 

the new item remains in the Media Library. 
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Upload a file to the Media Library 

In the Media Library, there are three different options to upload your media 

files: 

 Upload files – use this option to upload a single file or multiple files 

from the same location. 

 Upload files (advanced) – use this option to apply certain upload 

options. For example, you can upload a Zip archive or overwrite 

duplicates. 

 Drag & Drop – use this option to upload a single file or multiple files 

by dragging them from Windows Explorer to the Sitecore Media 

Library. 

Note: The drag-and-drop functionality is currently only supported in 

Internet Explorer 7 or later. If you use a different browser such as Mozilla 

Firefox, you must use the Upload files and Upload files (advanced) 

options to upload your files to the Media Library. 

Media files that you upload to the Media Library are not versionable by 

default. To make a media file versionable means that a new version of the 

media item is created automatically every time you edit it. In this way, after 

you have edited a media item, you have the option to revert back to an 

older version of the item. To make a media file versionable, you must either 

use the Upload files (advanced) option or set up the Drag & Drop option to 

make all media files that are uploaded that way versionable by default. 

Upload files 

To upload a single media file: 

1. In the Media Library, in the content tree, select the folder where you 

want to upload your media files to. 

2. In the editing pane, on the Folder tab, click Upload files. 
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3. In the Select file(s) to upload dialog box, browse to and select the 

media file that you want to upload and click Open. 

Note: To select multiple files, press and hold the CTRL key when 

you select the files. 

 

In the editing pane, on the Folder tab and in the Media section, you can 

see the images that you uploaded. The new items may contain a warning 

that you can remove if you open the media item and enter an alternate text 

in the Alt field. 



BCI.com Sitecore Publishing Guide Publishing basics 44 

 
 

 

Upload files (advanced) 

To upload files and apply certain upload options:  

1. In the Media Library, in the content tree, select the folder that you 

want to upload your media files to. 

2. In the editing pane, on the Folder tab, click Upload files (advanced). 

3. In the Select file(s) to upload dialog box, browse to the folder on 

your computer that contains the images you want to upload.  

Note: To select multiple files, press and hold the CTRL key when 

you select the files. 

4. Click Open. 

5. In the Upload Files dialog box, enter an alternate text for each media 

file and select the relevant upload option check boxes. 
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Upload option Description 

Unpack ZIP archives Select this option to upload and extract a Zip 

archive to the Media Library.  

In the .zip file, you can include subfolders with 

files. The folder structure is re-created in the 

Media Library after the files are extracted. 

Make uploaded 

media items 

versionable 

Select this option to make the media file 

versionable. This creates the media file in the 

selected language only, and any other language 

version that you want you need to create 

manually. 

Overwrite existing 

media items 

Select this option to upload a file with the same 

name as a file that already exists in the Media 

Library, if you want to overwrite the existing file.  

If you do not select this option, a duplicate file is 

created in the Media Library. 

Upload as files Select this option to store the file in the file 

system rather than in the database. 

6. Click Upload and the uploaded images are available in the selected 

folder in the Media Library. 

Drag & Drop  

If you work in Internet Explorer 7 or later, the drag-and-drop option is the 

quickest and easiest way to upload media files to the Media Library. You 

can upload single or multiple files from your computer to the Drag & Drop 
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dialog box. This is especially useful when you want to upload many files to 

different locations in Sitecore or from different locations on your computer. 

To drag and drop files to the Media Library: 

1. In a Media Library, select the folder that you want to upload the files 

to. 

2. To open the Drag & Drop dialog box, from the editing pane, on the 

Folder tab, click Drag & Drop. 

 

3. Open Windows Explorer and navigate to the folder where the images 

are stored and select the images you want to upload. 

4. Position Windows Explorer next to the Drag & Drop dialog box and 

drag the selected images from Windows Explorer to the Drag & Drop 

dialog box. 
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Note: If you need to upload files to or from other locations, you 

simply navigate through the folder structure either in the Drag & 

Drop dialog box or in Windows Explorer. You do not have to close 

the dialogs and start over. 

5. When you have dragged and dropped all your media files, click Done 

to copy them to the Media Library. 

Note: If the folder you copy to already contains a media items with 

the same name, the Copy File dialog box opens, asking you to 

decide how to handle the duplicate media items. 

In the editing pane, on the Folder tab and in the Media section, you 

can now see the images that you uploaded and that each new item 

contains a warning. 

6. To remove these warnings, open each media item and enter the 

alternate text in the Alt field. 

 

Edit a media item 

In the Media Library, you can edit media items such as images, documents 

and videos either using Sitecore tools such as the Image Editor for images 

or with other applications that you have installed on your computer such as 

Microsoft Word for documents or Photoshop for images. 

This topic outlines how to: 

 Edit a media item from the Media Library 

 Open and edit an image from the Image Editor 

 Edit an image in the image field 
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Edit a media item from the Media Library 

To edit a media item from the Media Library: 

1. In the Media Library, navigate to the item that you want to edit. 

2. On the Media tab, in the Media group, click Edit. The icon changes 

depending on the type of media item selected. For example:  

 If the media item is a Word document, you see a pencil as the 

associated icon. This opens the document in Microsoft Word. 

 

 If the media item is an image, you see an artist’s palette. This opens 

the image in the Sitecore Image Editor by default.  

 

3. For images, you can choose in which application you want to edit the 

image. Click Edit the drop-down arrow and select either: 

 Edit in Image Editor 

 Edit in Local Editor 

4. When you have finished editing your media item, save your changes 

and close the editor.  

5. In the Media Library, click Save. 

Note: If you edit the media item in a local editor, you must allow 

Sitecore to overwrite the original media item. In addition, if you have set 

up automatic versioning of media items, a new version of the media 

item is created only if you used a local editor.  
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Change the default image editor 

When you edit an image, you can change the default image editor to one 

on your local machine. In this way, when you click the upper part of the 

Edit button, the image opens up in your local editor instead of the Image 

Editor. 

To change you default image editor: 

1. In the Media Library, click the System menu and then click 

Application Options. 

2. In the Application Options dialog box, click the Media tab. 

 

3. In the Media edit button default section, select the Open editing 

application installed on user’s computer check box and click OK. 

Open and edit an image from the Image Editor 
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To open an image for editing in the Image Editor: 

1. Click the Sitecore Launchpad icon  at the top left of the page. 

2. Click Desktop   

3. Click the Begin icon.  

4. Click All Applications and then click Image Editor. 

5. In the Image Editor, in the ribbon, click Open. 

6. In the Select Media dialog box, select the image that you want to edit 

and click Select. 

You can find the image that you want to edit in the left menu, or you 

can use the filters or the search functionality. Alternatively, you can 

click Upload media to upload a new image. 
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Edit an image in an image field 

To edit an image in an image field: 

1. In the Content Editor, navigate to the item or page that you want to 

edit. To edit the image properties: 

 In the Content Editor, on the Content tab, scroll to the field that 

contains the image and click Properties. 

 

2. In the Image Properties dialog box make the relevant changes to: 

 The Alternate Text field - enter the text that you want to appear in 

the tooltip for the image. 

 The Dimensions section - specify the dimensions that the image 

should be displayed in, if they differ from the actual size of the 

image.  

 The Space section - specify how much space should be placed 

around the image. 
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3. To edit the image itself, you must open the image in the Image Editor, 

where you can crop, resize, flip, and rotate the image. To open the 

Image Editor: 

 In the Content Editor, on the Content tab, scroll to the field that 

contains the image and click Edit image.  

 

Note: You can also edit the image with any image editor that is 

available on your local computer. 
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4. When you have finished with editing the image, save your changes. 

5. To see your changes to the image: 

 In the Content Editor, save your changes. 

Important: All the changes that you make are applied to the version 

of the image that is stored in the Media Library and not just the copy 

that is shown on your web page. 

 

Carousels 

Carousels can be placed on several pages and on multiple locations on 

individual pages, but to edit the carousels you must find them in the 

Library section: 

 

Each carousel lives within a carousel folder named for the page that hosts 

it. 

To edit a carousel: 

1. Open the specific carousel page folder in the Library section. 

2. Select the carousel item and edit the following areas as 

needed: 

 CarouselImage 
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 CarouselKeyword 

 CarouselHeadline 

 CarouselCaption 

 CarouselLink 

  

 

 

 

 

 

 

 

 

To add a carousel item to a carousel: 

1. Open the specific carousel page folder in the Library section. 

2. Right-click on the page folder and select Insert from 

template. 
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3. Confirm that CarouselItem is highlighted in the 

PageComponents folder. In the Item Name field, create a 

name for your carousel item then select the Insert button: 

 

4. Select the carousel item and edit the following areas as 

needed: 

 CarouselImage 

 CarouselKeyword 



BCI.com Sitecore Publishing Guide Publishing basics 56 

 
 

 

 CarouselHeadline 

 CarouselCaption 

 CarouselLink 

 
5. Publish the carousel folder when complete. 

Modals 

Modals (also called “pop ups”) are small windows of content that appear 

when a specific link is selected on a current page. 

To edit, find the desired modal in the page on the content tree: 

 

Fill out the desired fields as you would a page: 
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Archive and restore an item 

You can archive items that you do not want to display on your website in 

the Content Editor. When you archive an item, it is not deleted but stored 

outside the content tree. Archived items can be restored at any time. 

This topic outlines how to: 

 Archive an item immediately 

 Archive an item at a later date 

 Restore an archived item 

Archive an item immediately  

To archive an item: 

1. In the Content Editor, in the content tree, navigate to the item that you 

want to archive.  

 If you want to archive a version of an item, click the Versions 

button and select the relevant version. 

 If you want to archive an item in a specific language, click the 

Language button and select the relevant language. 

2. To archive the item immediately, on the Review tab, in the Schedule 

group, click Archive: 

 To archive the item in all versions and languages, including all its 

subitems, click Archive item now. 

 To archive the current version and language of the item, click 

Archive version now. 
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3. Save your changes. 

Note: When you archive an item, it is removed from the content tree, 

but it remains on the published website. Therefore, the best practice 

would be to:  

1. Unpublish the item; then  

2. Archive it. 

 

Archive an item at a later date 

To archive an item: 

1. In the Content Editor, in the content tree, navigate to the item that you 

want to archive.  

 If you want to archive a version of an item, click the Versions 

button and select the relevant version. 

 If you want to archive an item in a specific language, click the 

Language button and select the relevant language. 

2. To schedule the archive of the item on a different date, on the Review 

tab, in the Schedule group, click Archive and then click Set archive 

date. 
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3. In the Archive Date and Time dialog box, specify the date and time 

you want to archive the item. 

 In the Archive item section, specify the date and time that you 

want to archive the item including all its versions and subitems. 

 In the Archive version section, specify when you want to archive a 

specific version of the current item. 

 

4. When you set a date and time, it is important to remember that: 

 If you only specify a date, the item is archived at 12:00 midnight on 

that date. 

 If you only specify a time, the item is archived at that time on the 

current date. 

 If you specify a date or a time that is in the past, the item is 

archived the next time that Sitecore checks for items to archive. 

5. Click OK and save your changes. 
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Note: When you archive an item, it is removed from the content tree, 

but it remains on the published website. Therefore, you must republish 

your website to ensure that these changes are replicated on your 

website. 

 

Restore an archived item 

To restore a content item from the archive: 

1. In the Sitecore Desktop, click the Sitecore Start button , All 

Applications, and then click Archive. 

2. In the Archive dialog box, select the item that you want to restore.  

 To restore all versions and languages of an item, including the 

subitems, select the item from the list. You can only restore one 

item at a time. 

 

 To restore a version of an item, in the Options group, select Show 

Versions, click the item that contains the version that you want to 

restore and in the lower pane that appears, select one or more 

versions to restore. 
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Note: You can select and restore as many versions of the same item 

as you want. 

3. In the Items group, click Restore and the items are restored in the 

content tree. 

 

Restore or remove a deleted item 

When you delete an item, the item is moved to the Sitecore Recycle Bin 

from where you can: 

 Restore an item or a version of the item. 

 Permanently delete individual items.  

 Empty the entire bin and permanently delete all items.  

To restore or remove an item from the Sitecore Recycle Bin: 

1. Open the Sitecore Launch Pad and click Recycle Bin. 

Alternatively, you can open the Recycle Bin from the Sitecore Start 

menu. 
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2. In the Recycle Bin dialog box: 

 To restore a single item, select the item in the list and click Restore.  

 

 
 

 To restore a version of the item, in the Options group, select the 

Show Versions check box to display all the deleted versions of the 

selected item. Then from the list of versions, select the version that 

you want to restore and click Restore. 

 

 

Note: When you restore an item or a version of an item, it is 

restored to its original place in the content tree. 
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 To permanently delete an individual item, select the item that you 

want to delete and in the Operations group, click Delete. 

 To empty and permanently delete the entire recycle bin, in the 

Operations group, click Empty. 

3. Click OK.  

 

Search 

The search engine in Sitecore lets you quickly search through all your items 

in the content tree. To help you locate exactly the item you are looking for, 

you can use the advanced search functionality, such as search filters and 

facets.  

Note: The search does not include your archived items. 

You can access the Sitecore search engine from every item in the content 

tree in the Content Editor. In the Content Editor, there is a Search tab next 

to the content tab of every item. Item buckets open directly on the Search 

tab because you need the search functionality to find and open hidden 

items in an item bucket. 

To run a search on an item in the content tree, in the content area, click 

Search and, in the new Search tab, enter your search criteria. The search 

runs through the selected item only. 
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If you want to run more than one search from the same item, you just open 

a new Search tab. You can open as many search tabs as you want. Each 

Search tab has a time stamp that gives you a reference to each specific 

search, for example, if you want to save a search.  

The search interface 

You also have the option to build a query, to view, and to filter the search 

results. 

 

 

Search field 

In the Search field, you enter the search query for your search. You can 

enter either free text, use the predefined search filters, or a combination of 

both. You can access the search options from the drop-down menu. 

More search options 
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If you click the drop-down arrow to the left of the search field, you open a 

list of pre-defined search options that you can use to optimize and speed 

up your search. You can, for example, open an item from a list of the most 

recently modified or opened items, select one of the pre-defined search 

filters, or apply one of the search operations to all the items returned by the 

search.  

Note: The administrator sets up the search engine and determines, for 

example, which search views and facets are available to you and whether or 

not you are able to see media items in the search results. 

View types 

The different views of the search results are available to the right of the 

search field. The default views are List View, Grid View, and Image View 

. If necessary, your administrator can activate several other views 

such as Tag View or Table View. 

Note: If you change the view, the search is launched again, based only on the 

keywords and filters in the Search field. 

Facets 

A facet is a way of categorizing the items returned by a search. For 

example, the items can be classified by author, language, or by when they 

were created. Once you have a list of search results, you can use the facets 

to filter the results further. 

Search results 

When you run a search, the results are listed below the search field. The 

search results contain basic information about the items returned, such as 

title, template, and version to give you a quick overview. From the list of 

search results, you can click an item to open it in the Content Editor. 
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Change your personal settings 

In the Sitecore Control Panel, you can set up your personal settings, for 

example your password or the region and language options, to make the 

application suit your needs. 

To change your personal settings: 

1. On the Sitecore Launchpad, click the Control Panel. 

 

2. In the Control Panel, in the My settings section, you can change the 

following settings: 
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 Change desktop background – in the Background field, select the 

image that you want to use, specify the position of the image and 

the color that you want to surround the image if it does not fill the 

screen.  

 Change Application options – in the Application Options dialog 

box, on the Content Editor tab, specify which elements you want to 

display on the Content Editor. On the View tab, you can customize 

the content tree. 

 Change password – in the Change Password dialog box, enter your 

current password and then enter and confirm your new password. 

 Change personal information – in the Personal Information dialog 

box, you can change your name, email address, and the image that 

you use as your portrait throughout Sitecore. 

 Region and language options – in the Regional and Language 

Settings dialog box, you can specify the formats that you want to 

use for numbers, currencies, times, and dates. In addition, you can 

specify the language that you want the client application to use. 
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 Reset to default settings – click to reset all your personal settings 

to the default settings. 

3. When you have finished setting up your personal information, click 

Back to return to the Launchpad. 



BCI.com Sitecore Publishing Guide BCI.com publishing guidelines 69 

 
 

 

BCI.com Publishing Guidelines 

The following guidelines and best practices will help with specific BCI.com 

pages to keep the style consistent. These instructions can be adapted as the 

site grows, but the basic style and formatting rules should be kept as close 

to the original information as possible. 

All pages: External links 

All external links should open in a new tab: 

 Rich Text Editor 

1. Highlight the text to link and select Hyperlink Manager from 

the ribbon: 

 
 

2. In the Hyperlink manager, insert the URL and select New 

Window from the Target drop down menu: 

 

 Content editor 

1. Select Insert external link: 
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2. Insert Link description, URL and select New browser from the 

Target window drop down menu, then click on the Insert 

button: 

 

All pages: Images 

 Sizes 

o Unless otherwise noted, all images should have a 4:3 aspect 

ratio and sized at 800x600 pixels. 

 Images with text overlay 

o Images that include text as an overlay should avoid white-to-

bright colors. Most overlay text is white, and some subhead 

text is teal. In order to increase readability, white or any 

colors that lean toward the bright spectrum should be 

avoided. 

All pages: Naming convention 

Adhering to the suggested SEO naming form will not only provide higher 

search results but create consistency throughout the site. The following 

rules should be followed when naming folders, items, and subitems: 
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 Folders, items, and files in the Media Library that are already 

published should never be renamed. This could cause links to break. If 

renaming is necessary, follow the unpublishing rules. 

 Spaces should never appear 

o Spaces are not recognized in search engines, so use hyphens 

between words. 

 Hyphens not underscore 

o Per SEO suggestions, hyphens are used as word separators 

while underscores do not specify any function in search 

parameters. 

 No upper case letters 

o Capital letters do not impact rankings. For consistency, avoid 

using upper case letters in URLs. 

 Dates 

 Blogs, news articles, and any other page or download that is related 

to a specific date should have the date entered at the end of the URL 

in DDMMYY format. EXAMPLES: 

blog-beyondsoft-calendar-081717 

case-study-cloud-dev-test-cloud 

datasheet-martech-110917 

Note: No date needed for case studies, as they aren’t date-specific. 

Navigation bar and footer 

The navigation bar and footer can be edited on the Home page, under the 

Navbar and Footer sections, respectively. 

 

Beyondsoft logo 

If the Beyondsoft logo needs to be updated and replaced at any time, the 

following steps should be followed: 
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1. Go to the Media Library and select the BCI folder. Locate the logo-

en-tm file and select it: 

 

2. Once the file is selected, scroll down to the Media section and select 

Detach. A dialog box will ask if you are sure you want to detach the 

file. Selecting the OK button unlocks the current image from the logo: 

 

3. To add a new image to the logo, select Attach and choose the file 

from the location on your local drive: 
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4. When the file is uploaded, save and publish the image file from the 

Media Library. 

 

Home Page 

 Carousel 

o Images should be 800x600 pixels. 

o Copy should be no more than 75 words and be tested to see if 

the size of the font or amount of words affects the carousel size. 

 

 News block (RelatedContent section) 

o EventHeadline: 

 Copy should be no more than 15 words and be tested to 

see if the size of the font or amount of words affects the 

box size. 

o EventImage 

 Image should be 800x600 pixels. 

o EventLink: 

1. Click on Insert link and navigate to the item 

2. Type “Read more” or “Learn more” in the Link Details box 

3. Select the Insert button  
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 NewsKeyword: 

o Insert “NEWS” 

 

 NewsHeadline: 

o Copy should be no more than 10 words and be tested to see if 

the size of the font or amount of words affects the box size. 

 

 NewsLink: 

1. Click on Insert link and navigate to the item 

2. Type “Read more” or “Learn more” in the Link Details box 

3. Select the Insert button  

 

 CareersKeyword: 

o Insert “CAREERS” 

 

 CareersHeadline: 

o Default copy: “Join our team” 

o Copy should be no more than 10 words and be tested to see if 

the size of the font or amount of words affects the box size. 
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 CareersBGImage 

o Image should be 800x600 pixels. 

 

 CareersLink: 

1. Click on Insert link and navigate to the item 

2. Type “Read more” or “Learn more” in the Link Details box 

3. Select the Insert button 

 

Solutions  

 Case study image and copy 

o Image should be 400x200 pixels. 

o Copy should be no more than 10 words. 

 

Solutions details pages  

o Services images should be 800x600 pixels. 

 

Industries 

 Tiles 

o Images should be 800x600 pixels. 

o See modals section for content instructions. 

 

Company 

 Leadership 

o Images should be 170x170 pixels. 

o See modals section for content instructions. 

 

 Awards and Certifications carousel 

o Images should be no more than 300 pixels wide and no more 

than 110 pixels tall. 

o See carousels section for content instructions. 
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 Beyondsoft Family carousel 

o Images should be no more than 310 pixels wide and no more 

than 200 pixels tall. 

o See carousels section for content instructions. 

 

Insights  

Events 

To enter events content: 

1. Right click on the Insights folder select Insert then select Events: 

 

2. In the Message dialog box that appears, use the naming convention 

style from above to enter a name and date for the event: 
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3. In Head section of the page, enter “Beyondsoft Consulting |” followed 

by the title of the event in the Title box: 

 

 

4. Enter event details in the AuthorTitleScopeDetails box by selecting 

Show editor and entering content in the rich text editor: 
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5. In the Backlink section, select Insert link then select 

Content>Insights. In the Description box, enter “SEE ALL EVENTS” 

then select the Insert button: 

 

6. In the SocialMediaLinksCaption box, enter “SHARE:” 

 

7. In the JumbotronImage section, select Browse, then find the case 

study image in the Insights/Events folder in the Media Library and 

click on the Select button: 
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8. Enter “Event:” and the related title in the JumbotronHeading box: 

 

9. In the InsightsDetailsContent section, in the ContentHeading box, 

enter the title of the event: 

 

10. Enter the copy for the event in the ContentBody by selecting 

Show editor and typing in the rich text editor box: 
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Note: If copying and pasting from an external source, the best practice for 

results is to paste the content into Notepad, then copying and pasting from 

Notepad to the rich text editor. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 

 

 
11. When content entry and formatting is completed, select 

Accept. 

12. In the InsightsSearchResultContent section, under 

InsightsCaptionImage, select Browse and navigate to the Media 

Library to the Images>Insights folder. Expand the folder and in the 

Tile images sub folder, choose a 200x200 image that is associated 

with the event: 
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13. Add a headline in the InsightsCaptionHeadline text box: 

 

14. Save and preview the page before publishing. 

 

Case studies 

To enter case study content: 

1. Right click on the Insights folder select Insert then select CaseStudy: 
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2. In the Message dialog box that appears, use the naming convention 

style from above to enter a name and date for the case study: 

 

 

3. In Head section of the page, enter “Beyondsoft Consulting |” followed 

by the title of the case study in the Title box: 
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4. In the InsightsDetails section enter “SCOPE” in the 

AuthorNameScope box by selecting Show editor and entering 

content in the rich text editor: 

 

5. Enter scope details in the AuthorTitleScopeDetails box by selecting 

Show editor and entering content in the rich text editor: 

 

 

6. In the Backlink section, select Insert link then select 

Content>Insights. In the Description box, enter “SEE ALL CASE 

STUDIES” then select the Insert button: 
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7. In the SocialMediaLinksCaption box, enter “SHARE:” 

 

8. In the JumbotronImage section, select Browse, then find the case 

study image in the Insights/Case Studies folder in the Media Library 

and click on the Select button: 
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9. Enter copy into the JumbotronCaption and enter “Case Study:” and 

the related solution in the JumbotronHeading box: 

 

10. In the InsightsDetailsContent section, in the ContentHeading 

box, enter the title of the case study: 

 

11. Enter the copy of the case study in the ContentBody by 

selecting Show editor and typing in the rich text editor box: 

Note: If copying and pasting from an external source, the best practice for 

results is to paste the content into Notepad, then copying and pasting from 

Notepad to the rich text editor. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 
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12. After content is entered and formatted, select Accept. 

13. In the InsightsSearchResultContent section, under 

InsightsCaptionImage, select Browse and navigate to the Media 

Library to the Images>Insights folder. Expand the folder and in the 

Tile images sub folder, choose a 200x200 image that is associated 

with the case study: 

 

14. Add a headline in the InsightsCaptionHeadline text box: 
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15. Save and preview the page before publishing. 

 

Data Sheets and White Papers 

To upload Data Sheet or White Paper files and create a download page: 

1. Go to Media Library, right-click the Files folder, select Upload File 

then select the desired file from your local drive: 

 

2. Go to Content Editor, right click on the Insights folder select Insert 

then select DataSheet or WhitePaper: 
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3. In the Message dialog box that appears, use the naming convention 

style from above to enter a name and date for the data sheet or white 

paper: 

 

 

4. In Head section of the page, enter “Beyondsoft Consulting |” followed 

by the title of the data sheet or white paper in the Title box: 
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5. In the Backlink section, select Insert link then select 

Content>Insights. In the Description box, enter “SEE ALL DATA 

SHEETS” or “SEE ALL WHITE PAPERS” then select the Insert button: 

 

6. In the SocialMediaLinksCaption box, enter “SHARE:” 

 

7. In the JumbotronImage section, select Browse, then find the data 

sheets or white papers image in the Insights/DataSheets or 
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Insights/Whitepapers folder in the Media Library and click on the 

Select button: 

 

8. Enter “Data Sheet:” or “White Paper:” and the related data sheet or 

white paper information in the JumbotronHeading box: 

 

9. In the InsightsDetailsContent section, in the ContentHeading box, 

enter the title of the data sheet or white paper: 

 

10. Enter the intro copy of the data sheet or white paper in the 

ContentBody by selecting Show editor and typing in the rich text 

editor box: 
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Note: If copying and pasting from an external source, the best practice for 

results is to paste the content into Notepad, then copying and pasting from 

Notepad to the rich text editor. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 

 

 

11. When content entry is complete, select Accept. 

 

12. To add the file to the download page, select Insert media link in the 

FileContent section, then select the Files folder. Click on the data sheet 

or white paper you uploaded earlier and add “Download the data sheet” 

or “Download the white paper” to the Link description text block. Click 

the Insert button to link the file to the page: 
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13. In the InsightsSearchResultContent section, under 

InsightsCaptionImage, select Browse and navigate to the Media 

Library to the Images>Insights folder. Expand the folder and in the Tile 

images sub folder, choose a 200x200 image that is associated with the 

data sheet or whitepaper: 
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14. Add a headline in the InsightsCaptionHeadline text box: 

 

15. Save and preview the page before publishing. 

 

News 

To enter news content: 

1. Right click on the Insights folder select Insert then select News: 
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2. In the Message dialog box that appears, use the naming convention 

style from above to enter a name and date for the news article: 

 

 

 

3. In Head section of the page, enter “Beyondsoft Consulting |” followed 

by the title of the article in the Title box: 
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4. In the InsightsDetails section enter the author name information and 

publish date in the AuthorNameScope box by selecting Show editor 

and entering content in the rich text editor (If a press release, insert 

contact information): 

 

Note: To maintain consistent styling, the date should be set at font size 4.  

For contact information the format should be as in the following example:  

Contact: (size 2) 

Macala Wright (with email link, size 4) 

Marketing Operations Lead (size 2) 

Beyondsoft NA (Size 2) 

5. If needed, enter category information in the 

AuthorTitleScopeDetails box by selecting Show editor and entering 

content in the rich text editor: 

 

 

6. In the Backlink section, select Insert link then select 

Content>Insights. In the Description box, enter “SEE ALL NEWS” then 

select the Insert button: 
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7. In the SocialMediaLinksCaption box, enter “SHARE:” 

 

8. In the JumbotronImage section, select Browse, then find the news 

image in the Insights/News folder in the Media Library and click on 

the Select button: 
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9. Leave the JumbotronCaption blank (unless the article is a press 

release”) but enter “News” in the JumbotronHeading box: 

 

10. In the InsightsDetailsContent section, in the ContentHeading 

box, enter the title of the article: 
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11. Enter the copy of the article in the ContentBody by selecting 

Show editor and typing in the rich text editor box: 

Note: If copying and pasting from an external source, the best practice for 

results is to paste the content into Notepad, then copying and pasting from 

Notepad to the rich text editor. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 

 

 

12. In the InsightsSearchResultContent section, under 

InsightsCaptionImage, select Browse and navigate to the Media 

Library to the Images>Insights folder. Expand the folder and in the 

Tile images sub folder, choose a 200x200 image that is associated 

with the news article: 
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13. Add a headline in the InsightsCaptionHeadline text box: 

 

 

14. When content is complete, select Accept then enter Publishing 

Settings - Select the PUBLISH tab at the top of the page, then select 

Change: 
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15. In the pop-up window, select the Publishable from and 

Publishable to dates and times, then select the OK button. This will 

keep content from becoming old: 

 

16. When complete, save and preview the page before publishing. 

 

Blogs 

To enter blog content: 

1. Right click on the Insights folder select Insert then select Blog: 
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2. In the Message dialog box that appears, use the naming 

convention style from above to enter a name and date for the 

blog: 

 

3. In Head section of the page, enter “Beyondsoft Consulting |” 

followed by the title of the blog in the Title box: 
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4. In the InsightsDetails section enter the author name information 

and publish date in the AuthorNameScope box by selecting 

Show editor and entering content in the rich text editor: 

 

Note: To maintain consistent styling, the date should be set at font size 4. 

5. Enter category information in the AuthorTitleScopeDetails box by 

selecting Show editor and entering content in the rich text editor: 

 

 

6. In the Backlink section, select Insert link then select 

Content>Insights. In the Description box, enter “SEE ALL BLOGS” 

then select the Insert button: 
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7. In the SocialMediaLinksCaption box, enter “SHARE:” 

 

8. In the JumbotronImage section, select Browse, then find the blog 

image in the Insights/Blog folder in the Media Library and click on 

the Select button: 
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9. Leave the JumbotronCaption blank but enter “Beyondsoft Blog” 

in the JumbotronHeading box: 
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10. In the InsightsDetailsContent section, in the ContentHeading 

box, enter the title of the blog: 

 

11. Enter the copy of the blog in the ContentBody by selecting 

Show editor and typing in the rich text editor box: 

Note: If copying and pasting from an external source, the best practice for 

results is to paste the content into Notepad, then copying and pasting from 

Notepad to the rich text editor. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 
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12. When content entry and formatting is complete, select Accept. 

13. In the InsightsSearchResultContent section, under 

InsightsCaptionImage, select Browse and navigate to the Media 

Library to the Images>Insights folder. Expand the folder and in 

the Tile images sub folder, choose a 200x200 image that is 

associated with the blog: 

 

14. Add a headline in the InsightsCaptionHeadline text box: 
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15. Save and preview the page before publishing. 

 

Careers 

 Employee quote carousel 

o See the Carousels section for updating. 

 

 Featured openings 

1. Go to the following URL for the most recent job listings: 

https://us-careers-beyondsoft.icims.com/jobs/search 

2. In the FeaturedOpenings section, enter the relevant copy 

in the FeatureOpeningHeading1 and 

FeatureOpeningLocation1 text boxes: 

 

https://us-careers-beyondsoft.icims.com/jobs/search
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3. In the FeatureOpeningLink1 section, click on Insert 

external link. In the dialog box that pops up, enter “Learn 

more” in the Link description text box. Enter the URL of 

the specific job opening and select New browser in the 

Target Window drop down menu, then select the Insert 

button: 

Note: You can select the Test button to see if the link is 

correct. 

 

Repeat the same steps for remaining FeatureOpeningHeading, 

FeatureOpeningLocation, and FeatureOpeningLink sections. 

 

 

Contact 

To enter contact content: 

1. Right click on the Insights folder select Insert then select 

OfficeContact: 
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2. In the Message dialog box that appears, enter the city/state or 

location for the contact: 

 

3. In OfficeContact section of the page, enter the city information in 

the OfficeLocation section: 

 

4. In the OfficeImage section, select Browse, then find the city 

image in the Contact Us folder in the Media Library and click on 

the Select button: 
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5. Enter the address and email link information in the OfficeAddress 

section by selecting Show editor and typing in the rich text editor 

box: 

Note: If copying and pasting from an external source, the best practice for 

results is to paste the content into Notepad, then copying and pasting from 

Notepad to the rich text editor. 

For consistency purposes, DO NOT update the size or class of the font. This 

could cause sizing issues, when viewing from mobile devices. 
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6. Add the country in the OfficeCountry text box: 

 

7. When content is complete, select Accept then save and preview 

the page before publishing. 

 

Fact Sheet 

To add content: 

1. When adding a row or column to a table, select Rich text editor 

and right click within the table. A selection pop-up window will 

appear. Click on the action you want: 
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2. Enter the content in the selected cell. 

NOTE: For consistency purposes, DO NOT update the size or class of 

the font. This could cause sizing issues, when viewing from mobile 

devices. 

 


